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Getting Started 

CamVerce Applications 

 

CamVerce comes with the following 7 applications. 

- CamVerce Launcher 

Launcher allows users to utilize all CamVerce applications from a single window.  

- CamVerce Recorder 

Recorder allows users to record computer screen, videos screen and computer screen as slides. 

This application can be also stated from CamVerce Launcher under Record tab. 

- CamVerce Studio 

Studio is for editing videos users created with CamVerce Recorder. Users can add various 

objects to CamVerce videos and edit frames. Please note that AVI files created using Recorder 

cannot be edited.  

- CamVerce Player 

Player can play videos created from CamVerce Recorder. This Player can play EMM file format 

(CamVerce Recorder file) and EMX file format (converted through CamVerce Converter). This 

wonΩt play AVI file format. 

- CamVerce Converter 

This application converts CamVerce Recorder project files or CamVerce Studio project files into 

various formats such as  EMX, EXE,SWF,AVI,ASF,WMV,MOV,RM,HTML,DOC and PPT                 

- CamVerce Update 

This application automatically updates your CamVerce up to date.           

 

 

System Requirements 

 

For Windows 2000 and XP: 

500 MHz processor - Recommended: 1.0 GHz  

256 MB RAM - Recommended: 1.0 GB 

16 MB video memory - Recommended: 250MB 

Sound cards with Full Duplexing 

Microsoft Internet Explorer 6.0 or later / Microsoft DirectX 9.0 or later / Microsoft Windows Media 

Player 9.0 or later. 

 

Microsoft Office 2000 or later for DOC, PPT conversion 



Real Player 7.0 or later to play RM file (Real Player is not required for conversion) 

QuickTime Player 9.0 or later for MOV file conversion 

Depending on videos you want to record, high-end system may be required.  

 

At least 1GB of space in local hard drive is required. Recording may be stopped if you have less than 500 

MB of space.  

 

For Windows Vista: 

 

Windows Vista 32 bit 

2 GHz processor or faster 

1 GB RAM or more 

128 MB video memory or more with DirectX 9 and WDDM driver support 

Sound cards with Full Duplexing 

Microsoft Internet Explorer 7.0 or later / Microsoft DirectX 9.0 or later / Microsoft Windows Media 

Player 11 (recommended) or later. 

 

Microsoft Office 2000 or later for DOC, PPT conversion 

Real Player 7.0 or later to play RM file (Real Player is not required for conversion) 

QuickTime Player 9.0 or later for MOV file conversion 

Depending on videos you want to record, high-end system may be required.  

 

At least  1GB of space in local hard drive is required. Recording may be stopped if you have less than 500 

MB of space. 

 

 

 

 

 

 

 

 

 

 



Installation 

 

Double click the installation file and you will see the CamVerce installation screen. Click Next to continue.  

 

 

The next screen will display the {ƻŦǘǿŀǊŜ [ƛŎŜƴǎŜ !ƎǊŜŜƳŜƴǘ όL{[!ύΦ wŜŀŘ ƛǘ ǘƘǊƻǳƎƘ ŀƴŘ ǎŜƭŜŎǘ άL ŀƎǊŜŜ 

ǘƻ ǘƘŜ ǘŜǊƳǎ ƻŦ ǘƘŜ ƭƛŎŜƴǎŜ ŀƎǊŜŜƳŜƴǘέ ŀƴŘ ŎƭƛŎƪ ǘƘŜ bŜȄǘ ōǳǘǘƻƴ ǘƻ ŎƻƴǘƛƴǳŜ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴΦ 



 

You can enter your name, Company Name and Serial Number in the next screen. If you are installing an 

ŜǾŀƭǳŀǘƛƻƴ ŎƻǇȅΣ ȅƻǳ ǿƻƴΩǘ ǎŜŜ ǘƘƛǎ ǎŎǊŜŜƴΦ tƭŜŀǎŜ ƴƻǘŜ ǘƘŀǘ ŀƭƭ ǘƘǊŜŜ ŦƛŜƭŘǎ ƘŀǾŜ ǘƻ ōŜ ŎƻƳǇƭŜǘŜŘ ƛƴ 

ƻǊŘŜǊ ǘƻ ƛƴǎǘŀƭƭ /ŀƳ±ŜǊŎŜΦ LŦ ȅƻǳ ŘƻƴΩǘ ǿƛǎƘ ǘƻ ŜƴǘŜǊ your company name, enter you name again in the 

Company field.  



 

From the next screen, you can select the installation options; Complete or Custom. For most cases, we 

ǊŜŎƻƳƳŜƴŘ ȅƻǳ ǘƻ Ǝƻ ǿƛǘƘ ά/ƻƳǇƭŜǘŜέ ƛƴǎǘŀƭƭŀǘƛƻƴΦ {ŜƭŜŎǘ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƻǇǘƛƻƴ ŀƴŘ Ŏƭƛck Next to 

continue.  



 

In the next screen, you can change the installation directory. The default location is set to C:\Program 

Files\ innoheim\CamVerce. If you wish to change the installation directory, click the Change button and 

select the location where you wish to install CamVerce. When the installation directory is selected, click 

Next to continue.  



 

You will see this confirmation screen. If you want to make changes to selections you have made, click 

the back button to make changes. Otherwise, click Next to install CamVerce.  



 

CamVerce is being installed on your computer. 



 

 

Depending on your system, you may see this small window while installing CamVerce. 

 

If you have this Confirm File Replace window, you computer already has updated files. Click the No to All 

button.  



 

 

Setting up audio device 

 

You will see this Computer Sound Options window.  

 



From this dialog box, you can select a device to record the sound coming from your computer, including 

sounds from movie clips. You may see a different list of devices unless you have the exact same system 

used for this instruction manual.  

 

²ƘŜƴ ȅƻǳ ŎƭƛŎƪ ǘƘŜ άtƭŀȅέ ōǳǘǘƻƴΣ ȅƻǳ ǿƛƭƭ ƘŜŀǊ ŀ ǎŀƳǇƭŜ ǎƻǳƴŘΦ {ŜƭŜŎǘ ŘŜǾƛŎŜǎ ƻƴŜ ŀǘ ŀ ǘƛƳŜ ŦǊƻƳ ǘƘŜ 

Devices box.  If you see sound waves in the Show Wave box, you know you can use that device. Adjust 

the Volume for the device and click the Select button. 

 

You may see waves from more than one sound device, depending on your sound card. We recommend 

you to go with a device that has larger waves. Generally, device names starting with Stereo or Mono are 

better sound devices than others for recording sound.  

If you have more than one sound card installed on your computer, you need to select the card from the 

Mixer Devices drop down menu and select a device for each Mixer device. 

If you have a webcam with an integrated microphone connected to your computer, it is possible for you 

to see two mixer devices in the Mixer Devices drop down menu. We recommend you to unplug your 

webcam to select the best device for recording. 

 

If you have selected the wrong device by mistake, you can always change it from CamVerce Recorder. 

FOR VISTA USERS: 

You will not see the computer sound setup screen. The audio device will be setup automatically in 
Windows Vista. However, you will need to select device for microphone.  

 

After selecting the device to record sound, you will need to select the audio device for microphone.   



 

The window is very similar to the one we saw for computer sound setup. Instead of clicking the Play 

button, you need tƻ ǘŀƭƪ ƛƴ ǘƻ ȅƻǳǊ ƳƛŎǊƻǇƘƻƴŜΦ ²ƘƛƭŜ ȅƻǳΩǊŜ ǘŀƭƪƛƴƎ ǘƻ ȅƻǳǊ ƳƛŎǊƻǇƘƻƴŜΣ ǎŜƭŜŎǘ ŘŜǾƛŎŜǎ 

ƻƴŜ ŀǘ ŀ ǘƛƳŜ ŦǊƻƳ ǘƘŜ 5ŜǾƛŎŜǎ ōƻȄΦ ²ƘŜƴ ȅƻǳ ǎŜŜ ǎƻǳƴŘ ǿŀǾŜǎ ƳƻǾƛƴƎ ƛƴ ǘƘŜ {Ƙƻǿ ²ŀǾŜ ōƻȄΣ ǘƘŀǘΩǎ 

the device you need to use for the microphone. Adjust the Volume for the device and click the Select 

button. 

 

 

 

 

 

 



VISTA USERS: 

You will see a different window: 
 

 
You need to select device from this list. Most of the time, the one with Microphone is the right device to 
record audio from the microphone. 
  

 

²ƘŜƴ ȅƻǳΩǊŜ ŘƻƴŜ ǎŜƭŜŎǘƛƴƎ ŘŜǾƛŎŜǎΣ ȅƻǳ ǿƛƭƭ ǎŜŜ ǘƘƛǎ ǎŎǊŜŜƴΦ  



 

Click the Finish button to close this installation window. When you click the Finish button, you will see 

shortcut icons for the CamVerce Application. Please refer to the first chapter for descriptions of each 

application.  

 

 

 

 

 

 

 



Installing LAME (MP3 Codec) 

After setting up the audio devices for recording, you need to install MP3 encoder. 

 

If you want to save your recording in MP3 format, you must have a LAME MP3 encoder installed on your 
computer. (CamVerce and liteRecorder don't come with the MP3 encoder). We recommend LAME 
MPEG Audio Layer III (MP3) encoder. 

LAME ƛǎ ǿƻǊƭŘΩǎ Ƴƻǎǘ ǳǎŜŘ ƻǇŜƴ-ǎƻǳǊŎŜ atо ŜƴŎƻŘƛƴƎ ŜƴƎƛƴŜ ŀƴŘ ƛǘΩǎ ŦǊŜŜǿŀǊŜΦ ƛƴƴƻƘŜƛƳ ǿŜōǎƛǘŜ ǿƛƭƭ 
be opened when you click the OK button. 

  

Download and open the zip file to extract the lame_enc.dll file. Copy this file into the folder where 
liteRecorder is installed. (C:\ Program Files\ innoheim\ CamVerce) 
 
As of July 2008, LAME 3.97 is the most current version. If you would like to have more information about 
LAME, please visit The LAME Project page.  

http://lame.sourceforge.net/index.php


 

 

 

 

 

 

 

 

 

 

 

 

 



CamVerce Launcher  
(Will now bŜ ǊŜŦŜǊǊŜŘ ǘƻ ŀǎ άLauncherέ for the rest of the manual) 

 

Launcher is a program manager that allows you to access CamVerce applications easier and faster. To 

start Launcher, click the Start button > All Programs > innoheim > CamVerce >Launcher. If you have 

placed a shortcut on your desktop, simply double click it.  

 

If you are using an evaluation copy of CamVerce, you will get a message box indicating number of days 

remaining for the evaluation. 

As you can see from the picture below, Launcher has four tabs: Record, Edit, Play and Convert. Each is 

linked to CamVerce Recorder, CamVerce Studio, CamVerce Player and CamVerce Converter, respectively. 

You can minimize this launcher by clicking the minimize button (the minus sign in the top right corner) 

and close it by clicking the close button. (the x in the top right corner) 

 

 

 

Record Tab 

 

LetΩs take a look at whatΩs under the Record tab: 



The Record tab is the default tab you see first when you launch the program as recording is the first step 

you would do with CamVerce. From this tab, you can launch 3 recording wizards (Desktop Recording 

Wizard, Video Recording Wizard and Slide Recording Wizard, respectively) and CamVerce Recorder.  

If you click one of the first three recording options, this Launcher will disappear and the corresponding 

recording wizard will appear. These wizards will be covered in the CamVerce Recorder chapter. When 

you close the applications, this wizard will re-appear so you can launch the next applications easily.  

 

 

Edit Tab 

 

LetΩs take a look under the Edit tab. You will see this screen when you click the Edit tab:  

 

This Edit tab is linked to CamVerce Studio which can be used to edit what you have recorded with the 

CamVerce Recorder. You will see a list of files you have recently worked on and this Launcher will 

disappear. CamVerce Studio will start upon clicking the button that says άRun CamVerce Studio for 

editing.έ When you ŎƭƻǎŜ ǘƘŜ /ŀƳ±ŜǊŎŜ {ǘǳŘƛƻ ǿƘŜƴ ȅƻǳΩre done, this Launcher will re-appear.  

 

You will also notice that the list of recent files is updated with the file you just worked on. You can 

simply double click on the name of the file and you can open this project in CamVerce Studio.  

 



 

Play Tab 

 

LetΩs take a look at Play tab. The Play tab is linked to the CamVerce Player. You can view projects you 

recently worked on from the list and play the project by clicking the button that says άRun CamVerce 

Playerέ.  

 

As the case with the other tabs, this Launcher will disappear upon clicking the button. You can play 

CamVerce Recorder files, EMM format and CamVerce Converter files, and EMX format from CamVerce 

Player. When you close the player, the Launcher will re-appear.  

You will notice that the list of recent files is updated with the file you just played as you can see from the 

picture below.  



 

You can also double click on the name of the file and you can play this project on CamVerce Player. 

 

 

Convert Tab 

 

LetΩs take a look at the Convert tab. Like other tabs, the Convert tab shows you the list of your recently 

worked files. Upon clicking the button at the bottom, this Wizard will disappear and CamVerce 

Converter will start. When youΩre done with the Converter and close it, the Launcher will re-appear and 

the list will be updated. You can also double click on the name of the file to open the file from Converter.  

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CamVerce Recorder  
(²ƛƭƭ ōŜ ǊŜŦŜǊǊŜŘ ǘƻ ŀǎ άRecorderέ in this Chapter) 

 

Overview 

Important information for Windows Vista users: 

- You need to log in as an administrator for proper recording.   

- You need to turn the protected mode off when you are recording Internet Explorer 7 (You may 

have to do this in Windows 2000/XP as well). If you have this enabled, mouse cursor movement 

may not be recorded properly. This is one of MicrosoftΩs policies to prevent hacking program 

controls mouse.  

-  If you donΩt turn the protected mode off or not logged on as an administrator, your mouse 

pointer may stay one shape when you record.  

- If you have more than 2 speakers, you need to change the speaker settings to Stereo to record. 

- You are not able to change the audio settings.  

 

 

The Recorder application is the recording tool of CamVerce applications. You can capture footage of 

your computer desktop, any videos playing on your computer, or take screenshots of your desktop while 

youΩre recording your mouse cursor and your voice. If you have recorded your desktop or taken 

screenshots (Slide Recording), you will be able to edit or convert the project using CamVerce Studio and 

CamVerce Converter.  

You can use the Launcher application to start Recorder or by clicking the Start button > All Programs > 

innoheim > CamVerce >Recorder. Please note that if you donΩt start Recorder from the Launcher, you 

wonΩt be able to use the recording wizard. This is the Recorder main window. 



 

 

 

Recording with Recording Wizard 

 

LetΩs record using the Record Wizard. You can use recording wizards only from CamVerce Launcher. 

Start the Launcher and click the first button (Record Computer Screen) 



  

You will see a άHardware !ŎŎŜƭŜǊŀǘƛƻƴέ window. This window will help you set the hardware 

acceleration automatically when youΩre recording. It is recommended to set the hardware acceleration 

to None when youΩre recording and you can restore it back to Full after youΩre done recording. Please 

note that you must set the hardware acceleration to None if youΩre recording video screen.  

  

If you click the Yes button, CamVerce will automatically change the hardware acceleration to None 

whenever you record and restore it back after you exit CamVerce. You can change this setting from 

Recorder by clicking Tools menu > Automatic Hardware Acceleration. You can also tick the box next to 

άDonΩt show this againέ and this window will not appear.  

 

Note: You will not see this window if youΩre using Windows Vista 

 



Recording Wizard Step 1 

 

You will see the first step of the Screen Recording Wizard as shown below.  

 

 

As you can see, there are three different recording options in Recording Wizard and they are Full Screen, 

Window Frame and Custom Size.  

 

Full Screen 

Full screen records your entire desktop and you can change the Display Settings to change the resolution 

from Display Properties (Windows 2000/XP) and Display Settings (Windows Vista).   



  

 



 

You can also change the display resolution from the wizard easily. Select the display resolution and color 

quality from the drop down menu and click Change Now to change the settings.  

 

We recommend you to change the color quality to 16 bits when you record since you will get a much 

smaller  file size. Please note that the most commonly used display settings are 1024X768 (16 bit) and 

800X600 (16 bit). 1024X768 is the most ŎƻƳƳƻƴ ǎŎǊŜŜƴ ǊŜǎƻƭǳǘƛƻƴ ŀƴŘ ȅƻǳ ŘƻƴΩt want to make the 

video bigger than your viewerΩs screen resolution because then the full recorded screen will not be able 

to be viewed.  

 

 

Window Fame 

 



 

The Window Frame recording lets you select and record individual window frames. If you want to record 

in Window Frame mode, select the Window Frame and click ǘƘŜ άSelect Windowέ button.  



 

You will notice that the wizard disappears. When you move your cursor around your desktop over any 

opened applications, the window frame the mouse cursor is hovering  over will be highlighted with grey 

dotted lines. If you have the window frame you want to record selected, click the left mouse button.  

You will notice that the wizard will re-appear and the selected frame is highlighted in Pink with 

coordinates.  

 

Custom Size 

The Custom size recording is the most popular recording mode. After selecting the Custom Size button, 

you can either enter the coordinates manually in Starting Points and Width, Height boxes or drag and 

drop the area you wish to record.  If you donΩt want to enter the coordinates manually, select the 

Custom Size button and click the Select Area button. The wizard will disappear just like the Window 

Frame option but you will notice that the mouse cursor will change to hand shape ǿƛǘƘ ŀ άҌέ ǎƛƎƴ as 

shown in picture below.  



 

 

¸ƻǳ Ŏŀƴ ŘǊŀǿ ŀ ǊŜŎǘŀƴƎƭŜ ǳǎƛƴƎ ǘƘŜ ΨŘǊŀƎ ŀƴŘ ŘǊƻǇΩ ǘŜŎƘƴƛǉǳŜΦ /ƭƛŎƪ ǘƘŜ ƭŜŦǘ ƳƻǳǎŜ ōǳǘǘƻƴ ŀƴŘ ƘƻƭŘ ǘƘŜ 

button while you are moving the cursor to cover whole movie area. If the rectangle covers the area you 

wish to record, release the mouse button.  

The recording area will be displayed in pink with coordinates on it. If the selected recording area is too 

small or too big, you can change the size and location by changing the Starting Point and Width, Height. 

You can also click the Select Area button again to re-select recording area. 

 

If the width or height of the selected recording area is odd number, it will be automatically rounded to 

an even number.  



 

You can select whichever recording mode is best for you. After selecting the recording mode and 

recording area, click the Next button to the second step.  

 

 

 

Recording Wizard Step 2 

 

In the second step, you can select the audio recording option. There are three audio options available to 

choose from; Computer Sound, Microphone and Custom. If you select Computer Sound or Microphone, 

the device you selected during the installation will automatically be used. If you want to use custom 

audio device, select the Custom option and click the Change Options button to select the audio device 

from the list.  



 

Click Next to continue.  

 

 

Recording Wizard Step 3 

 

From this last step of the Wizard, you can select the Project name and work directory and verify selected 

recording information.  

I have changed the Project Name to CamVerce Project 1 as you can see from the picture below.  



 

Note: that screen recording and slide recording are saved as a project in CamVerce and each projects 

saves in one directory. For example, the picture above will create a project called CamVerce Project 1 

and this project will be saved in C:\CamVerce\CamVerce Project.  

 

 

If you wish to change the Work Directory, click the Browse button. By default, CamVerce will create a 

folder named CamVerce in the My Documents  folder and each project is saved under separate folders 

in the CamVerce folder.  

 

Other Options 

You can click the Other Options button to change audio recording options, Background Music, Sound 

Effect, Cursor/Draw option and miscellaneous options.  



 

You can change the Audio recording options from here,  as well as add background music and sound 

effects which will be played when you press any key from your keyboard or click (left, middle and right) 

on your mouse. If you wish to use the sound effect option, select the event from the drop down menu 

and click the Browse button to find a WAV or MP3 file to assign to the event. Please note that if you 

select MP3 file, CamVerce will automatically convert the file into WAV format.  



 

We will go more in depth about the Other Options screen in a later chapter. You can now verify the 

information under Recording Information and click Finish to continue recording.  

 

 

Recording 

 

Upon clicking the Finish button, you will see this small window notifying you that recording will begin as 

soon as you click the OK button.  

 



The recording will begin if you click the OK button and you will go back to the Launcher if you click 

Cancel. You will notice this small Stop/Pause button at the bottom right hand side of your screen.  

 

This small window not only contains the  Stop and Pause button but enables you to write on your screen 

while youΩre recording or add capture screenshots as slides. You can also stop and pause recording by 

right clicking on CamVerce tray icon and selecting Pause or Stop. You can also assign keyboard short cut 

keys to pause and stop recording. Alt -F11 is assigned for Pause and Alt-F12 is for Stop by default. 

 

If you click the Draw on Screen button, you can draw on screen while youΩre recording. If you click the 

icon, you will see the Draw on Screen toolbar and you can select drawing options (line, shape, eraser, 

color and link thickness) from there. When youΩre done drawing, click the green button with the arrow 

and your drawing will disappear. If you have drawn something by mistake, you can click the undo button.  

 

 

 

End Recording and saving 

 

When youΩre done recording, you can stop the recording by whichever method you prefer. You will see 

this Recording Complete window where you can enter your information as shown in picture below 

(Name, Home Page, email and description) .  



  

The Advanced tab will show you advanced video and audio information.  

 



You will be prompted to convert the file to an editable file format. You need to convert the recorded file 

into an editable file format in order to edit it from CamVerce Studio. If you donΩt convert the file, you 

wonΩt be able to re-record the narration.  

 

When you click the Yes button, the recording session will be done and the launcher will re-appear.  

  

 

 

 

 

 



Video Recording using Recording Wizard 

 

Recording Wizard Step 1 

 

Video recording creates an AVI instead of project file and will record computer sound instead of from 

the microphone. The first step of the video wizard is the same as the screen recording wizard except 

Custom Size is selected as default. You can select Full screen or Window Frame if you wish.  

 

 

Video recording takes more system resources depending on your computer system. It is recommended 

to resize the video as small as possible before you record. You may experience choppy recording if your 

recording area is too big. It is always good to test record for 5 minutes to see if you can record properly 

under the current setting.  

 

Recording Wizard Step 2 

 



As you may notice in the second step, Computer Sound is selected as default. This second step is same 

as the screen recording wizard.  

 

The last step is slightly different than the screen recording wizard. You can enter the file name and work 

Path instead of Project name and location. As mentioned earlier, video recording will create an AVI file 

directly and these files cannot be edited or converted using CamVerce Studio or Converter.   

 

Recording Wizard Step 3 

 



 

The Mouse cursor will not be recorded, you canΩt insert background music or sound effects and you 

ŎŀƴΩǘ draw using Draw on Screen while recording.  

 

 

 

 

 

 

 

 

 

 



Recording without wizards 

 

Recorder Tabs 

Recording Area Tab 

 

You can either click άRun CamVerce Recorderέ from the launcher or click the Start button > All Programs 

> innoheim > CamVerce >Recorder to start CamVerce Recorder. This is the main screen of CamVerce 

Recorder.  

 

The Recorder has 3 left tabs (recording modes) and 5 right tabs (recording options).  Like the wizard, you 

can select recording modes from Desktop Recording, Video Recording and Slide recording in the left tabs.  

 



Video Tab  

From the Video tab, you can change hardware acceleration option manually. If you have selected 

Automatic Hardware Acceleration option, the current setting should say άIŀǊŘǿŀǊŜ ŀŎŎŜƭŜǊŀǘƛƻƴΥ Noneέ.  

 

You can also change the number of frames per second. You change the frame rate between 1 ς 30, but 

10 frames per second is recommended and multiple of 5 is also recommended.  

 

You can also change the Key Frames Interval value and 100 (default) is recommended. If you do change 

it, keep it under 200.  

 

Faster Compression is set as default for video compression level for optimum recording. However, you 

may want to change it to Better Compression to minimize the file size. Please note that you may have 

choppy recording quality depending on what you record if you have Better Compression since itΩs slower.  



If you select Capture layered window option, you will be able to record semitransparent windows or 

animation enabled windows. The most popular layered window would be the animated help feature in 

Microsoft Office. 

 

System Priority option enables you to prioritize running applications. If you are not familiar with this 

feature (from WindowsΩ Device Manager), leave it as is (Normal) 

 

Audio Tab 

From the Audio tab, you can select the audio recording option, add/edit background music and sound 

effects. You can change these options the same way in the recording wizard. If you are recording video, 

you will not be able to add background music and sound effects. 

 

 



Cursor/Draw Tab  

You can change settings for your cursor (mouse pointer) and Draw on Screen options.  

 

 

There are two types of mouse pointers; normal shape and shape when you click. You can change these 

pointers to one of the following shapes: None, Diamond, Square and Circle. If you select Square for 

Mouse left click effect, your cursor will change whenever you click your left mouse button so your 

viewer can see that.  

 



 

 

You can also change the color and size of the cursors.  



 

This mouse cursor will be effective when you start recording. You can only use this mouse effect when 

you are recording your desktop or capture your desktop as slides. If you donΩt want to record the mouse 

cursor, uncheck the άRecord mouse cursorέ box.  

If you wish to write while you record, check the box beside Enable real time draw , we will explain a little 

bit more about the Draw on Screen feature in later chapter.  

  

Etc Tab 

In the last tab, you can select shortcut keys and show/hide options for Stop/Pause buttons, taskbar icon 

and selected recording area. If you unselect the άselected recording areaέ, the pink border around the 

area you want to record wonΩt show.  



 

 

If you are recording a video screen, you wonΩt be able to use shortcut keys for Draw on Screen and Slide 

Recording.  



 

 

 

Slide Recording 

 

LetΩs look at slide recording. Slide recording captures screen shots of your desktop instead of recording. 

You can capture screens you want to capture and play them like a slide show.  

You voice will be recorded even while youΩre not capturing the screen and mouse movement will be 

recorded as well. If you are recording a screen which doesnΩt have lots of movement, this slide recording 

is recommended. Since youΩre capturing a comparatively less number of screenshots compared to 

screen recording, the size of the file will be significantly smaller than a recorded file.  

If you wish to go with slide recording, select the Slide Recording tab and capture the screen shot by 

clicking the slide capture button from Stop/Pause button of using keyboard shortcut. 



 

We have covered CamVerce Recorder in this chapter, ƴƻǿ ƭŜǘΩǎ ǳǎŜ ǘƘŜ Recorder.  

 

Recording and saving 

 

I will begin with άScreen Recordingέ and άFull screenέ. Click the Screen Recording tab and select Full 

Screen.  Then proceed to click the Record button.  

 

 



New Project window will pop up. You can enter any name you want for your first project and change the 

location by clicking the Browse button if you want to. I will leave it to the default  location, but change 

the project name to CamVerce Tutorial.  

 

You will then see another pop up saying άPlease click άOKέ button to start recording.έ Click OK to start 

recording.  

 

When youΩre done, click the Stop button which you can find at the bottom right hand side of your screen. 

You will see a screen where you can enter your information and check the results of the recording.  



 

When youΩre done, click OK. 

  

You will see a warning message stating that you need to convert this file to an editable file. Click άYesέ to 

convert your file.  

 

When youΩre done, you will have the CamVerce Recorder back on your screen. If you recorded with 

Recorder, you can click the Play button to view what you just recorded.  

 

If you have selected Video Recording, you will get ŀ άSave asέ windows instead of άProjectέ window 

because this will record directly to AVI format. 



  

You can enter the name you want to save the file as and click ǘƘŜ άSaveέ button. After saving your file, 

you will see this dialog box where you can set options for AVI files.  

As you can see from the dialog box below, you can choose which compression program (Codec) you 

want to use. Microsoft MPEG-4 Video Codec V3 Codec with default values is recommended for standard 

recording. 



 

If you have specific Codecs you would like to use, you can select from the drop down menu to configure 

them manually. When you are done, click the OK button to start recording.  

 

Your recording will begin immediately after you click the OK button. You can stop recording by pressing 

your shortcut key (if you have selected one) or clicking the Stop button. You can also watch what you 

have recorded by clicking the Play button from CamVerce Recorder main window. The recorded movie 

will be played on your default video player, not CamVerce Player.  

 

If you have selected Slide Recording, you will also see the New Project window just like Screen Recording. 

You can enter your project name and location just like you did in screen recording.  



 

You will notice that the Slide Capture button is enabled. You will be able to capture screenshot by 

clicking this button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CamVerce Recorder features 

 

Recorder has a few more features which the recording wizard doesnΩǘΦ 

- You can change the sound device you have selected during the installation to a different one 

from the Recorder. 

   

Changing audio devices 

 

Click the Tools menu and select Computer Sound Options to pull up the Computer Sound settings 

window. From this window, you can select a device to record the sound coming from your computer. 

 

 



²ƘŜƴ ȅƻǳ ŎƭƛŎƪ ǘƘŜ άtƭŀȅέ ōǳǘǘƻƴΣ ȅƻǳ ǿƛƭƭ ƘŜŀǊ ŀ ǎŀƳǇƭŜ ǎƻǳƴŘΦ {ŜƭŜŎǘ ŘŜǾƛŎŜǎ ƻƴŜ ŀǘ ŀ ǘƛƳŜ ŦǊƻƳ ǘƘŜ 

Devices box. When you see sound waves in the Show Wave box, you know you can use that device. 

Adjust the Volume for the device and click the OK button to record sound. 

You may see waves from more than one sound device, depending on your sound card. We recommend 

you to go with a device that has larger waves. Generally, device names starting with Stereo or Mono are 

better sound devices than others for recording sound.  

If you have more than one sound card installed on your computer, you need to select the card from the 

Mixer Devices drop down menu and select a device for each Mixer device. 

If you have a webcam with an integrated microphone connected to your computer, it is possible for you 

to see two mixer devices in the Mixer Devices drop down menu. We recommend you to unplug your 

webcam for best recording results. 

 

You can change the microphone settings as well from the Tools menu > Microphone Options.  

  



 

 

 

Automatic Hardware Acceleration 

 

You can also change settings for Automatic Hardware acceleration from Recorder. Click the Tools menu 

> select Automatic Hardware Acceleration. 



 

 

 

Changing working directory  

 

The last menu from the Tool menu allows you to change the default location for the project directory. 

By default, your project directory is set to be within the CamVerce folder in My Documents. If you create 

a new project, a folder named the same as the project will be created under the CamVerce folder.  



 

 

 

Draw on Screen features 

 

You can draw while you record by clicking ǘƘŜ άDraw on Screenέ icon from Stop/Pause recording button 

or the Alt-F7 key on your keyboard. You can change this keyboard shortcut from the Etc. tab if you want 

to. You will see this Draw on Screen menu.  

 

 

If you have a tablet connected to your computer, you can use the pressure-sensitive Brush tool. If you 

ŘƻƴΩǘΩ have one, the Brush tool will be greyed out.   

 

There are three shapes you can choose from; Line, Rectangle and Oval. 

 



If you draw something by mistake, you can erase it in three different ways; Eraser, Clear Selection and 

Erase all. You can use the Eraser tool just like the Pen tool. If you select Clear Selection, everything inside 

the rectangular box you drew with your mouse or tablet will be erased. Erase All will erase everything 

you draw.  

 

You can change the color and line thickness for Pen or Line tools. 

 

 

If you have drawn something by mistake, you can click on the Undo button. There is a maximum of 5 

undo/redo are supported. 

 

The last button allows you to set short cut keys for tools in Draw on Screen 



 

 

 

 

 

 

 

 

 

 

 

 



CamVerce Studio 
 

Overview 

 

You can use CamVerce Studio to easily edit videos recorded with CamVerce Recorder. CamVerce offers 

simple ways to edit both frames and objects. You can edit screen recording videos and slide recording 

videos, but you canΩt edit AVI files.  

 

You can open CamVerce Studio wither from the Launcher or click the Start button > All Programs > 

innoheim > CamVerce >Studio. This is StudioΩs main screen.  

 

 

 



Opening a project from Studio 

 

As you can see, there is no project opened yet. Click File Menu and select Open Project. IΩm going to 

open project.emp file in this tutorial. 

 

We have Project.emp file opened in Studio now. Now youΩre ready to edit.  



 

There are three main components of Studio:  Toolbars at the top, slide window at the bottom and the 

main editing windows in the middle.  

Toolbars are used to add and edit objects. You can also change the properties of the objects. 

You can edit frames and change the length of objects from the slide window. You can have an overview 

of the video including the total length of the video.  

The main editing window and slide windows are linked together. The selected frame from the slide 

window will display in the main editing window.  

 

 

 

 



Object Editing  

 Available objects on CamVerce 

 

Basic 

Objects  

  

 Draw a line. You can change the shape to an arrow  

 Draw an arrow  

 

Draw a rectangle. You can insert text inside of the rectangle and change the test font style and 

color. You can also change the color of the rectangle, line width of the border or add shadow to 

the rectangle.  

 

Draw an oval. You can insert text inside of  the rectangle and change the test font style and color. 

You can also change the color of the oval, line width of the border or add a shadow to the oval.  

Filled 

Objects  

  

 

Draw a filled rectangle. You can insert text inside of the rectangle and change the test font style 

and color. You can also change the color of the rectangle, line width of the border or add shadow 

to the rectangle.  

 

Draw a filled oval. You can insert text inside of the rectangle and change the test font style and 

color. You can als o change the color of the oval, line width of the border or add a shadow to the 

oval.  

 

Rounded Rectangle: Draw a rounded rectangle. You can insert text inside of the rounded rectangle 

and change the text font style and color. You can also change the color of the rounded rectangle, 

line width of the border or add shadow to the rounded rectangle.  

 

Rectangular Callout: Draw a rectangular callout. You can insert text inside of the rectangular 

callout and change the text font style and color. You can also change the color of the rectangular 

callout, line width of the border and add a shadow to the rectangular callout.  

 

Oval Callout: Draw an oval callout. You can insert text inside of the oval callout and change the 

text font style and color. You can also change the color of the oval callout, line width of the border 

or add a shadow to the oval callout.  

 

Rounded Rectangular Callout: Draw a rounded rectangular callout. You can insert text inside of the 

rounded rectangular callout and change the text font style and color. You can also change the 

color of the rounded rectangular callout, line width of the border or add a shadow to the rounded 

rectangular callout.  

Other 

Objects  

  



 

Add a text box. You canôt change the color of the text box, but  you  can change the text font style 

and color.  

 

Graphic files: You can insert bitmap image files (BMP, GIF, JPG, PNG and TIF) and vector image 

files (WMF and EMF). You can adjust the transparency and color of the image files and add text on 

top of the image files.  

 

Interactive Objects: This object allows users to make bi -directional (Success/Fail) video from user 

input (keyboard or mouse). Please note that this interactive feature is only playable on CamVerce 

video formats only.  

 

Audio: Audio is used to play audio file on a certain frame. PCM type WAV and MP3 files formats 

can be used.    

 

Logo: You can insert your company logo if you want to. When the user clicks on the logo, they will 

be directed to your homepage.  

  

 

Adding a basic object and basic object properties 

 

LetΩs add, edit and delete objects on an actual video.  

I will add a rectangle at 2 second of the video. Select the 3 second from the slide widow. You can either 

click on the little arrowhead beside the Filled Objects icon from the toolbar and select άRectangleέ or 

select άRectangleέ from Insert menu > Basic Objects.  



 

 

Move your mouse cursor to the main editing window and you will notice that your mouse pointer will 

change to ŀ ά+έ. You can hold down the left mouse button and draw a rectangle. DonΩt worry if you 

draw the rectangle too big or small, you can change the size or location later.  

 



 

 

You can see this rectangle from the slide window. By default, objects will be displayed for 5 seconds 

from the frame you add an object from. We will learn how to make the object display longer later in this 

chapter.  

You will see 8 handles around the rectangle. You can resize this rectangle by dragging one of these 

handles. You can locate your cursor anywhere in this rectangle and hold down the mouse button and 

move around your mouse to re-locate the rectangle.  

 

 

Adding text to an object 

 

LetΩs add text to the rectangle. Select the rectangle and click the Edit Text button from the toolbar. You 

can also right click on the rectangle and select Edit Text menu. Now you can enter the text. 



I will type άCamVerce TraininƎέ. When youΩre done, click anywhere outside of the text box.  

 

I will change the font style and size from the Edit Text toolbar. I have changed the font to Verdana, 24 

and center aligned. 


